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Author Questionnaire 
1. Microscopy: Does your protocol require the use of a dissecting or stereomicroscope for performing a complex dissection, microinjection technique, or something similar?  No  
If Yes, can you record movies/images using your own microscope camera?
Enter Yes or No.  
If your protocol involves microscopy but you are not able to record movies/images with your microscope camera, JoVE will need to use our scope kit. 
If your microscope does not have a camera port, the scope kit will be attached to one of the eyepieces and you will have to perform the procedure using one eye.

Enter make and model of microscope.

2. Software: Does the part of your protocol being filmed include step-by-step descriptions of software usage?  Yes	
If Yes, we will need you to record using screen recording software.
We recommend using the screen capture program OBS. JoVE’s tutorial for using OBS Studio is provided at this link: https://www.jove.com/v/5848/screen-capture-instructions-for-authors?status=a7854k
As these files are necessary for finalizing your script, please upload all screen captured video files to your project page as soon as possible.

3. Filming location: Will the filming need to take place in multiple locations?   No
If Yes, how far apart are the locations? Click to enter distance between locations.

To ensure that your script can be filmed in one day, the Protocol section is restricted to 55 shots (shots are the 3-digit numbers like 2.1.1, 2.1.2…etc)

Current Protocol Length

Number of Steps:  23
Number of Shots:  50


Introduction
1. Introductory Interview Statements

Videographer: Obtain headshots for all authors. 

Your answers to these questions will become author interview statements, which authors will memorize and then deliver on camera.
· Enter the full name of the author who will deliver the statement.
· If possible, each author should deliver no more than two statements.
· Fill out both required statements, one optional statement may also be selected.
· Answer in full sentences, in a style suitable for being spoken aloud. 
· Limit the length of each statement to 30 words or fewer.
· Answers will be edited for length, clarity, and consistency with journal style guidelines.

REQUIRED: Why is your protocol significant? OR What key questions can this method help answer? 
1.1. Phillips: All organisms have disorder in their proteome – up to 33%. These regions are observable by hydrogen/deuterium-exchange mass spectrometry only in the millisecond timescale. Our protocol will show you how to do this successfully.

REQUIRED: What is the main advantage of this technique?
1.2. Phillips: This is a fully automated analytical technique – you set everything up and program the desired measurements, hit “go” and walk away. 

OPTIONAL: Do the implications of this technique extend toward the therapy (or diagnosis) of a particular disease, disability, or challenge? How so?
1.3. Seetaloo: This technique does open up the exciting possibility to screen for compounds that stabilize a specific conformation of intrinsically disordered proteins, such as alpha synuclein.

OPTIONAL: Are there any specific areas of research that this method could provide insight into? OR Can this method be applied to any other systems?
1.4. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.

OPTIONAL: How would you expect an individual who has never performed this technique to struggle? Do you have any advice to offer to somebody who is trying this technique for the first time?
1.5. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.


Introduction of Demonstrator on Camera

Complete this statement ONLY if any of the individuals who will be demonstrating the procedure on camera will not be delivering an Introductory Interview Statement.

1.6. Dr Jonathan Phillips: Demonstrating the procedure will be Neeleema Seetaloo, a graduate student from my laboratory. Include additional demonstrators as needed.  
1.6.1. INTERVIEW: Author saying the above. 
1.6.2. The named demonstrator(s) looks up from workbench or desk or microscope and acknowledges the camera.

1.7. 

Protocol
Please review this section to make sure that it accurately describes your protocol. Use Track Changes when making edits or revisions.
· The one-digit numbers represent sections of the video. The text will appear onscreen.
· The two-digit numbers (e.g. 2.1., 2.2.) represent steps of your protocol. The text will be recorded by a professional voiceover talent. 
· The three-digit numbers (e.g. 2.1.1., 2.2.2.) represent the shots that our videographer will capture at your lab. 
· To ensure that your protocol can be filmed in one day, the protocol is restricted to 25 steps and/or 55 shots. 

Please use this draft script to help you prepare for filming day.
· Filming should take no more than 10 minutes per step. If a step will take more than 10 minutes, prepare the product from that step in advance.

2. Peptide Mapping Procedure
2.1. To begin sample preparation for peptide mapping, first, take a vial of stored aSyn (A-sin) protein stock from the minus 80 degrees Celsius freezer [1] and once it is thawed, filter it using a 0.22-micrometer syringe filter [2]. 
2.1.1. WIDE: Talent taking out aSyn stock from - 80°C freezer.
2.1.2. Talent injecting aSyn solution through a 0.22 µm filter into a new tube.

2.2.  Then measure the absorbance of the solution at 280 nanometers to determine the protein concentration using Beer and Lambert’s law [1] and dilute the protein with equilibrium buffer to a final concentration of 5 micromolar [2]. 
2.2.1. Talent putting a cuvette with the solution into a spectrophotometer
2.2.2. Talent adding protein solution to a tube of equilibrium buffer with a pipette

2.3. Next, to set up the autosampler robot, add 50 microliters of the 5 micromolar protein solution to a total recovery vial [1] and place the vial in the sample position in the right chamber of the hydrogen-deuterium exchange or HDX (H-D-X) mass spectrometer [2-TXT]. 

2.3.1. Talent adding 50 µL of the 5 µM protein solution to a total recovery vial.
2.3.2. Talent placing the vial in the sample position of the HDX right chamber. TXT: The temperature of the chamber should be 0.5°C

2.4. Then put one vial of equilibrium buffer and two vials of labeling buffer to reagent positions one, two, and three of the left chamber [1] and set the temperature at 20 degrees Celsius using the Peltier temperature controller [2]. Next, put one vial of quench buffer to reagent position one in the HDX right chamber [3]. 

2.4.1. Shot of vials of equilibrium buffer and labeling buffer at reagent positions 1, 2, and 3 of the HDX left chamber.
2.4.2. Talent using the Peltier temperature controller 
2.4.3. Shot of the vial of quench buffer to reagent position 1 of the HDX right chamber.

2.5. Then add a total of eight recovery vials in the reaction positions of the HDX left chamber [1] and a maximum of eight recovery vials in the reaction positions of the HDX right chamber [2].  Next, set up a sample list with appropriate LC (L-C) and MS (M-S) methods in the scheduling software and start the schedule [3]. 
2.5.1. Talent putting a recovery vial in a reaction position of the HDX left chamber
2.5.2. Talent putting a recovery vial in a reaction position of the HDX right chamber
2.5.3. Talent working with the scheduling software on the computer.

2.6. To obtain the final peptide coverage map, manually curate the isotopic assignments in the DynamX (dynam-ex) HDX data analysis software [1]. 
2.6.1. Talent using the DynamX HDX data analysis software on the computer.
3. Millisecond Hydrogen/Deuterium Exchange Study
3.1. Before starting HDX experiments, first, clean the FastHDX (Fast-H-D-X) prototype instrument [1] and open the graphical user interface of the compatible HDX software to initialize the system [2]. 
3.1.1. Talent cleaning the FastHDX instrument.
3.1.2. Talent opening the graphical user interface of the HDX software on the computer.
3.2. Enter 20 degrees Celsius and 0.5 degrees Celsius as the Sample Chamber and Quench Chamber temperatures, respectively, followed by clicking Set to apply the new temperatures [1].
3.2.1. SCREEN: Sample Chamber and Quench Chamber temperature are being set and Set is clicked 
Authors: Please acquire screen capture videos for all shots labeled SCREEN and upload them to your project page https://www.jove.com/account/file-uploader?src=19535298
3.3. Next, set up the centrifuge tubes with LC-MS  grade water at all inlets [1]. Then check both left and right syringes in the Titrator Plumbing Delivery tab [2] and continue clicking Prime until all latent air bubbles in the tubes are gone [3]. 
3.3.1. Shot of a centrifuge tube with LC-MS grade water at an inlet
3.3.2. SCREEN: Titrator Plumbing Delivery tab is open
3.3.3. SCREEN: Prime is getting clicked

3.4. To check all the boxes for syringes, first, go to the Macros tab and click on Calibrate Syringes Home Position [1]. Then first click Wash Syringe Load Loop [2], followed by Wash All Mixing Loop Volumes [3]. 
3.4.1. SCREEN: Calibrate Syringes Home Position is clicked.
3.4.2. SCREEN: Wash Syringe Load Loop is clicked.
3.4.3. SCREEN: Wash All Mixing Loop Volumes is clicked. 

3.5. If there is any bubble in a buffer syringe, disconnect the syringe [1] and degas it by vertically ejecting the bubble [2]. Before recalibrating to the zero position, replace the syringe [3]. 
3.5.1. Talent removing the syringe.
3.5.2. Talent vertically holding the syringe.
3.5.3. Talent putting the syringe back in position.

3.6. For setting up the FastHDX prototype instrument for HDX experiments, first, add 500 microliters of 5 micromolar aSyn to a total recovery vial [1]. To prevent temperature-induced oligomerization and aggregation, place the tube in a tabletop fridge [2].  
3.6.1. Talent adding 500 µL of 5 µM aSyn solution to a total recovery vial.
3.6.2. Talent putting the vial of aSyn in a tabletop fridge.

3.7. Next, add 50 milliliters of equilibrium, labeling, and quench buffers to the respective buffer inlets in the right and left chambers of the instrument [1] followed by the addition of 50 milliliters of column wash buffer to the pepsin wash inlet [2]. 
3.7.1. Talent adding 50 mL of equilibrium buffer to the equilibrium buffer inlet in the right chamber.
3.7.2. Talent adding 50 mL of column wash buffer to the pepsin wash inlet.

3.8. For priming the protein and column wash lines, check the right and left syringes in the Titrator Plumbing Delivery tab [1] and click Prime once [2].
3.8.1. SCREEN: Titrator Plumbing Delivery tab is opened.
3.8.2. SCREEN: Prime is clicked. 

3.9. After checking all the boxes for syringes, as demonstrated earlier, go to the Manual Quench Flow tab to enter the required settings [1]. For a time-course experiment, use the Symbolic Dots button to enter the times in milliseconds [2-TXT]. 
3.9.1. SCREEN: Manual Quench Flow tab is opened.
3.9.2. SCREEN: Symbolic Dots buttoon is clicked. TXT: Add the same timepoint multiple times for replicates

3.10. Then set the Trap Time (mins) (Pronounce as ‘trap time’) to 3 [3] and the Wait for HPLC (mins) = (trap time + run time + 1.5 min) (Pronounce as wait for HPLC to trap time plus run time plus fifteen minutes) [4]. 
3.10.1. SCREEN: Trap Time (mins) space is entered
3.10.2. SCREEN: Wait for HPLC (mins) = (trap time + run time + 1.5 min) space is entered

3.11. If blank experiments are run between sample runs, click on the Run Blank box after ensuring an entry in the software for the blank run after each sample run [1]. Once the sample list is ready and the appropriate entries have been highlighted, start the run by clicking Play and FastHDX in the software [2]. 
3.11.1. SCREEN: Run Blank is clicked
3.11.2. SCREEN: Play and FastHDX are clicked

4. Data Processing and Data Analysis
4.1. For data processing, open the File menu of the file of spectrally assigned peptides from the peptide mapping experiments [1] and click Open in the DynamX software [2]. Then import the raw files to the DynamX software [3].
4.1.1. SCREEN: File menu of the file of peptides is clicked
4.1.2. SCREEN: Open is clicked in DynamX software.
4.1.3. SCREEN: A file is transferred to the DynamX software. 

4.2. After opening the Data menu, click on MS Files [1]. To create states for each protein condition being studied, click on New State [2]. To add each HDX timepoint, click on New Exposure [3]. Then click New Raw to import raw files, drag each file to the correct position, and click OK when finished [4].
4.2.1. SCREEN: Data menu is opened and MS Files is clicked.
4.2.2. SCREEN: New State is clicked. 
4.2.3. SCREEN: New Exposure is clicked. 
4.2.4. SCREEN: New Raw is being clicked, file is being dragged to correct position and OK is clicked 

4.3. After automatically assigning isotopes, manually curate the isotopic assignment to ensure high data quality [1]. 
4.3.1. SCREEN: Isotopic assignments being curated. 

4.4. Export the cluster data in a .csv (dot-c-s-v) file with the column order as described in the manuscript  [1]. Open the Data menu in the mass measurement software [1] and click on Export Cluster Data [2].
4.4.1. SCREEN: Data is being exported
4.4.2. SCREEN: Data menu is clicked in mass measurement software.
4.4.3. SCREEN: Export Cluster Data is getting clicked. 

1. 
2. 
3. 
4. 
4.1. 
4.2. 
4.3. 
4.4. 
4.5. For data analysis, first, load the exported clustered data into the HDX analysis software  HDflex (H-D-flex) [1]. To fit the experimental data for all experiments and states, select the appropriate back exchange correction methods to get the observed rate constants for the HDX reaction [2].  	Comment by Swati Madhu: Authors: Will this be performed using a computer? If yes, please provide a short 5-7 second screen capture video along with rest of the screen capture footage.	Comment by Phillips, Jonathan: We have supplied the screen capture videos
4.5.1. SCREEN: Data is being loaded
4.5.2. Talent clicking the computer mouse

4.6. Then calculate a global significance threshold using a preferred method in HDflex and perform hybrid significance testing to determine the significant differences across the states compared [1].
4.6.1. SCREEN: Global significance threshold is being calculated and hybrid difference testing is being done	Comment by Swati Madhu: Authors: We require only a short representative screen capture video of 20 seconds here. If it gets longer than that, please just provide 2 screenshot showing calculated significance threshold and significant difference after hybrid significance testing	Comment by Phillips, Jonathan: We have uploaded one to our JoVE page. Please let us know if it needs some changes and we can reacquire.


Protocol Script Questions
Authors: Please use the step and shot numbers from the script above (not step numbers from the manuscript) when answering the questions below. Do not include steps that will be screen-captured and do not list entire sections.

1) Which steps from the protocol are the most important for viewers to see? Please list 4 to 6 individual steps (steps are indicated with the 2-digit numbers, like 2.1, 2.2, etc.). 

3.5, 3.6, 3.7, 3.11, 4.5, 4.6

2) If a dissection or stereo microscope is required for your protocol, please list all shots that will be visualized using the microscope (shots are indicated with the 3-digit numbers, like 2.1.1, 2.1.2, etc.).

[bookmark: Text3][bookmark: Text2]Click here to list microscope shots, using the shot numbers from the protocol section of the video script.     



Results
Please review this section to make sure that it accurately reflects your findings.
· Use Track Changes when making edits or revisions.
· If you would like the video to include different results, please revise this section.
· When revising, please keep the length of the voiceover below 200 words. Current word count: 94 (Voiceover is the text that follows the two-digit numbers)
· Please note that the video cannot include voiceover without an accompanying visual. 

5. Measuring the Conformational Dynamics of aSyn

5.1.  The mapping experiment on aSyn generated a peptide coverage map that covered
         100 percent of the protein sequence with an average redundancy of 3.79 [1]. 
5.1.1. LAB MEDIA: Figure 1

5.2.   Moreover, this protocol enabled the generation of deuterium uptake curves for
         different peptides of aSyn [1], which were then expressed as fitted and back
         exchange corrected graphs [2]. It was evident that most hydrogen-deuterium 
         exchange in aSyn was done by one second [3]. 
         
        5.2.1.  LAB MEDIA: Figure 3A
        5.2.2.  LAB MEDIA: Figure 3B
        5.2.3.  LAB MEDIA: Figure 3C. Video editor: Please emphasize the yellow region of the graph besides 1000 ms in the y-axis

      6.3.   The conformational difference between states A and B of aSyn was also evident from
                the higher deuterium uptake by state B both at the peptide [1] and amino acid levels
                 [2]. 

                5.3.1.  LAB MEDIA: Figure 4A
                5.3.2.  LAB MEDIA: Figure 4B



Conclusion
1. [bookmark: _Hlk27388131]
2. 
3. 
4. 
5. 
6. Conclusion Interview Statements

Below are prompts for interview statements that can be used to further emphasize the significance of your protocol. 
· Answer one or two of the prompts below.
· Limit the statements to 30 words.
· Answer the questions in full sentences; you will need to memorize and deliver the interview statements during filming. 
· Indicate the full name of the author who will deliver each statement. 
What is the most important thing to remember when attempting this procedure? Please indicate the steps (e.g., 2.4., 2.5.) in the Protocol section of the script that this advice applies to.
6.1. Phillips: (4.6) It is critical that you use a robust statistical significance test when comparing data for such a sensitive technique – here we use our software, HDfleX.
Following this procedure, what other methods can be performed? What questions would these additional methods answer?
6.2. Enter author name: Click here to answer. Please use language that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
After its development, did this technique pave the way for researchers to explore new questions within a specific scientific field? If so, how?
6.3. Enter author name: Click here to answer. Please use language that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.


Thank you for addressing our questions. We will incorporate your answers and suggestions, and send you the final script before your filming day. You will also receive detailed preparation instructions in the email accompanying the final script.
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